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1. Introduction 

1.1 Document purpose and scope 

This document introduces the procedures to deploy Intel® Education Theft Deterrent 
solution for version 4.x.  

The document contains the following information: 

 Introduction to the Theft Deterrent solution 

 Requirements of the Theft Deterrent server depending on the deployment scenarios 

 Deployment steps for the Theft Deterrent server 

 Steps to migrate from earlier versions of the Theft Deterrent server to version 4.x 

 Pre-configuration steps of the Theft Deterrent server 

 Configuration steps to enable the Theft Deterrent server to use a separate download 
server 

 Deployment steps for the Theft Deterrent client and guardian 4.x 

 Troubleshooting and FAQ 

1.2 Terminology 

1.2.1 Abbreviations 

Abbreviation Description 

server Theft Deterrent server 

client Theft Deterrent client 

1.2.2 Terms 

Term Description 

device Intel® classmate PC or Intel® Education Tablet 

online devices The devices that are connected with the server network and their clients 
are activated and communicating with the server. 

Sponsor server Theft Deterrent run in Sponsor mode, which can manage the Proxy and 
TD server in central-server supported mode. 

Proxy server Theft Deterrent run in Proxy mode, which can register in Sponsor server 
and need keep the sync-up with Sponsor server for TD feature. 

Non-Proxy 
server 

Theft Deterrent run in central-server supported mode. 

 

1.3 Revision History 

Revision Date Comment 

0.62 2013/9 Add usage for server upgrade package and add re-install 
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Revision Date Comment 

server section. Update the migrate tool usage 

0.63 2013/11 Move migrate section to Toolkits User Guide. 

Add one dependency for Linux client. 

0.64 2014/6 Change TD server minimize Hard disk size request 

0.8 2014/12 Update for TDv3 RC1 new release 

0.9 2015/3 Add offline register for TDv3 RC2 release 

0.91 2016/6 Modify Performance Tune 

1.4 Reference Document 

Document Date 

Intel® Education Theft Deterrent server User Manual 2013-04 

Intel® Education Theft Deterrent client User Manual 2013-02 

Intel® Education Theft Deterrent Root CA Server Deployment Guide 2013-04 

Intel® Education Theft Deterrent Central Server Deployment Guide 2013-07 

Intel® Education Theft Deterrent Toolkits User Guide 2013-11 

Intel® Education Theft Deterrent manufactory guide 2013-11 
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2. Theft Deterrent Overview 

As part of the Intel® Education Software suite, Theft Deterrent provides a complete physical 
security management solution for your Intel® Education Tablet and Intel® classmate PC. 

Note: The term device is used throughout this document to refer to Intel® Education 
Tablet and Intel® classmate PC. 

At first, you need understand your deployment environment, like: 

 Business requirement, like what is business model of hosting and sustaining the 
solution? 

 Network environment, like how about the internet connectivity in school? 

 IT technology background, like whether school IT has the capability to manage the 
server?  

 Security consideration, like whether the school can maintain the server hardware 
secure. 

Figure 1 - Theft Deterrent High level Architecture 

And prior to deployment, it is necessary to understand the different components of Theft 
Deterrent: 

 Root CA server: Each Theft Deterrent solution must contain one root CA server. This 
server generates and manages the root key pair, trusted by every Theft Deterrent 
client that it manages. 

 Theft Deterrent (TD) servers: Key components of the Theft Deterrent solution, 
which provide feature, including device and certificate management, device 
locking/unlocking etc. Refer to next sections on how to select the TD server mode 
and relative deployment architecture. 
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 Theft Deterrent client (client): This component runs on devices and can connect 
with Theft Deterrent server to update the certificate for lock and unlock devices 
based on the certificates received from the Theft Deterrent server.  

Note:  Central server is the legacy TD server component. TDv3 Sponsor server can run 
as a central server as well, so a separately central server is not recommended. 

2.1 Server Support Mode 

TDv3 server provides several modes during install and you can access different 
functionalities with different modes: 

Installation Mode  Description 

Stand-alone mode 
with the Intel Root 
Public Key 

The server can run standalone without connect with any other 
server.  It cannot be transformed to other modes. 
 
As the Root key is from Intel, this mode is only target to test or 
demo. It is not recommended for real deployment. 

Central Server 
supported mode 

Must be activated to a Central server (or a Sponsor server 
running as Central server). 
Need connect with Central server for online backup and school 
transfer features. 
 
Can access other features without connect with any other server. 

Proxy mode  Must be activated to a Sponsor server. 
Need keep sync-up with Sponsor server for TD features. 

Stand-alone mode 
with your own Root 
Public Key 

Can run standalone to access TD features. 
 
It has several possibility to be transformed to other modes: 
- After activate to Central server, it transforms to the Central 

Server supported mode. 
- After activate to Sponsor server, it transforms to the Proxy 

server. 
- After being registered and activated, it will be updated to 

Sponsor server and run as a Central server as well. It can 
manage both Proxy server and TD server in central-server 
supported mode.  

Note: It is one way transformation and cannot be reversed.  

 
Proxy mode and central server supported mode provide more functionality compared with 
the Standalone server. Below is the functionality comparison between them, which can help 
you to understand the new features Proxy mode provided. 

  Central server supported 
mode 

Proxy mode 

Add-in 
functionality 

Online 
transfer 

Y. Must keep central 
server and Root server 
online. 

Y. Simplified transfer 
procedure with Assign group 
in Sponsor server. 

Online Y.  Y. Simplified backup through 
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backup sync-up between Sponsor 
and Proxy. 

Centralized 
management 

Partially. Can view 
device information in 
Central server. 

Y. Sponsor server can 
manage all devices belong to 
Proxy server. 

Security Request? High. Need keep the 
server safety. 

Low. The Proxy server can 
run in low secure mode. 

Run without any other 
server? 

Y. Can run without 
Central server online. 

N. Must keep sync-up with 
Sponsor server for it cannot 
lock/unlock device after all 
prefetched certificates 
expired. 

 
In Summary, the Proxy mode provides more functionality and has lower safety requirement, 
while it will need the regular sync-up between the Proxy and Sponsor server. 

2.2 Deployment Workflow 

In general, a new deployment of the Theft Deterrent solution follows this order: 

1. Deploy root CA server. The Root CA server is suggested to be located in MoE centre. As 
to detail step on how to deploy the root CA server, see the Intel® Education Theft 
Deterrent Root CA Server Deployment Guide. 

2. Choose the TD Architecture: Before deployment, you need understand your internet 
environment for the server. There are 4 typical deployment scenarios and 
corresponding suggested TD architecture.  
 

Deployment 
Scenario 

Network environment TD Architecture 

A School has good internet connectivity 
and no network congest at daytime. 

Centralized architecture, or 
Intel cloud service 

D School has no internet. Decentralized architecture 

B/C School has not good internet (even no 
internet), while need the centralized 
management or need more safe 
solution for school admin cannot keep 
school server safety. 

Hierarchized architecture 
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Figure 2 - Theft Deterrent Deployment Scenario 

 
3. Deploy TD server solution: After identified your TD architecture, follow next section on 
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deployment steps. 
5. Once deployment completes, you cannot change the Root Public Key used in the Theft 

Deterrent solution. Make sure that you deployed the server with the correct mode 
before you connect any device to the server.  

Note: As to Standalone mode is easiest mode to install and can be transferred to other 
modes after some operation. It is highest recommend to install a server as Standalone 
mode if possible. 

2.3 Theft Deterrent Solution Architecture 

You can deploy the Theft Deterrent solution with one of the following architectures 
according to the network, management and security request: 

 Centralized and Intel cloud service 

 Decentralized 

 Hierarchized 

2.3.1 Centralized Architecture and Intel cloud service 

If Internet connection is stable at region or country level, MoE can host the concentrative 
server by themselves or utilize the cloud service hosted by Intel. 

2.3.1.1 Centralized Architecture 

MoE can host the concentrative server in MoE data center or in the cloud. 

TD 
Sponso
r server 

P
r
o
x
y
 
s
e
r
v
e
r 

T
D
 
s
e
r
v
e
r 

… 

P
r
o
x
y
 
s
e
r
v
e
r 

Scenar

io A: 

School 

Scenari

o D: 

 Scenario B: 

School has 

intranet. But 

MOE 

School

internet 

internet 

internet 

TD 
Sponsor 
server 

P
r
o
x
y
 
s
e
r
v
e
r 

… 

P
r
o
x
y
 
s
e
r
v
e
r 

 Scenario C: 

School has 

offline 

offline 

Internet Connection Good Poor 

TD 
se
rv
er 



Intel® Education  Theft Deterrent Deployment Guide Revision 1 

  - 7 - 

Figure 3 - Centralized Architecture 

 

The deployment options selected for this architecture is as follows: 

Deployment Configurations Recommended Configuration 

Root key pair Your own root key pair 

Concentrative server Standalone mode with your own Root Public Key. 

2.3.1.2 Intel Cloud service  

If customer permits Intel to get the private information of end users, they can utilize the 
cloud service running by Intel, to save the cost for IT and secure maintenance. 

Intel cloud service provide feature: 

 Patch for Server Operation system 

 Setup, upgrade and backup, trouble shooting for issue relative the server 

 Create account for MoE and operator and help them to manage the device belong to 
them 

URL of Intel cloud service is service.theftdeterrent.intel.com. Please refer to Section 8.3 on 
how to pre-set the address. 

Note: Now the Intel cloud service is running in pilot and mainly target for demo purpose. 

2.3.2 Decentralized Architecture 

The server is hosted at individual school LAN level in decentralized architecture. Select this 
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Figure 4 - Decentralized Architecture 

 

The deployment options selected for this architecture is as follows: 

Deployment Configurations Recommended Configuration 

Root key pair Your own root key pair 

School server Stand-alone mode with your own Root Public Key 

2.3.3 Hierarchized Architecture 

There are 2 layers TD servers are hosted in hierarchized architecture. 

 Concentrative server at MoE centre or cloud.  

 School server at individual school level.  
o For school without stable internet connection, the school server is hosted in 

school LAN. 
o For school has stable internet connection, the school server is not 

mandatory for devices can direct connect to the concentrative server. 

Figure 5 - Hierarchized Architecture 
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Deployment Configurations Recommended Configuration 

Root key pair Your own root key pair 

Concentrative server Install with Standalone mode.  

After activated, it will run as Sponsor mode. Except devices 
management, it also can manage the Proxy or non-Proxy 
server.  It enables centralized management feature and more 
security capability. 

School server For school server, it can install with Proxy mode or Central 
Server Supported mode. 

Identify the server mode according to security, network and 
management requirement in school. 

2.4 Choose Download Server Locations 

Once you determine the options for the Theft Deterrent architecture, you can consider 
having a separate download server for better performance or scalability of your server: 

Figure 6 - Theft Deterrent server Options 

Online device 

number < 5K

Local download 

server

Separate 

download server

 

The server includes a Smart Client Upgrade function which provides clients (TD client above 
4.x) with upgrade packages through HTTP or HTTPS download. You can deploy the feature 
with either of the following methods: 

 Local: Deploy the download feature as a feature of the web service.  

 Separate: Use a third-party download server to provide the download feature. 

In general, it is recommended that you deploy the server on the Internet with a separate 
download server if the number of online devices it manages is larger than 5K. 

You can configure the server to specify the location where clients should download the 
packages according to the location of the download feature chosen. Detailed configuration 
steps are introduced in chapter 7. 
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3. Theft Deterrent server Requirements 

3.1 Requirements for Decentralized Architecture 

This section introduces the requirements for deploying the server in the decentralized 
architecture. This architecture deploys the server on LAN in schools and the general 
deployment scenario assumes that the number of devices to be managed is less than 5K.  

It is recommended that you deploy the download feature in local. 

The hardware and network requirements for the server are as follows: 

Online 
devices 

Requirement Recommended configuration Minimal configuration 

< 1K 
Hardware 

CPU: 1 x Intel® Xeon®, 2 cores 
Memory: 2 GB 

CPU: 1 x Intel® Xeon®, 1 cores 
Memory: 2 GB 

OS Linux or Windows Linux or Windows 

Network 
bandwidth 
(Mbps) 

4 2 

< 5K 
Hardware 

CPU: 1 x Intel® Xeon®, 4 cores 
Memory: 4 GB 

CPU: 1 x Intel® Xeon®, 2 cores 
Memory: 4 GB 

OS Linux or Windows Linux or Windows 

Network 
bandwidth 
(Mbps) 

10 4 

The minimum hard disk space required is 2GB. However, the recommended hard disk space 
for the server is 30 GB and above. 

3.2 Requirements for Centralized Architecture 

This section introduces the requirements for deploying the server in the centralized 
architecture. This architecture deploys the concentrative server on the Internet at region or 
country level. Therefore, the general deployment scenario assumes that the number of 
devices to be managed is more than 5K. First of all, the following requirements must be met: 

 The server must be protected against network DDoS attack. 

 All the schools and students at home must be able to access the server with enough 
bandwidth and network latency, which should be less than 300ms in both directions. 

It is recommended that you deploy the server with the separated download server third-
party provided. Also, do not share the download bandwidth with the web server bandwidth. 
Otherwise, the downloading might use too much bandwidth and cause network congestion 
which will prevent devices from connecting with the server. 
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3.2.1 Requirements for Theft Deterrent server 

The requirements for the server differ according to the network latency, which will cause 
time delay when data transmits between the server and the clients. To estimate the latency 
of your network, see Appendix.  

If your network latency <= 300ms, refer to the server requirements displayed in the 
following table. If your network latency > 300ms, contact your local TME for support.  

Online 
devices 

Requirement Recommended configuration Minimal configuration 

< 10K Hardware CPU: 1 x Intel® Xeon®, 4 cores 

Memory: 4 GB 

CPU: 1 x Intel® Xeon®, 2 cores 

Memory: 4 GB 

OS Linux or Windows Linux or Windows 

Network 
bandwidth 
(Mbps) 

2  1  

10-50K Hardware CPU: 1 x Intel® Xeon®, 4 cores 
with hyper-thread 

Memory: 8 GB 

CPU: 1 x Intel® Xeon®, 4 cores 

Memory: 8 GB 

OS Linux or Windows Linux or Windows 

Network 
bandwidth 
(Mbps) 

9  4  

50-100K Hardware CPU: 2 x Intel® Xeon®, 4 cores 
for each with hyper-thread 
Memory: 16 GB 

CPU: 2 x Intel® Xeon®, 4 cores 
for each with hyper-thread 
Memory: 12 GB 

OS Linux Linux 

Network 
bandwidth 
(Mbps) 

18  9  

100-
200K Hardware 

CPU: 2 x Intel® Xeon®, 6 cores 
for each with hyper-thread 
Memory: 24 GB 

CPU: 2 x Intel® Xeon®, 4 cores 
for each with hyper-thread 
Memory: 16 GB 

OS Linux Linux 

Network 
bandwidth 
(Mbps) 

35  18  

 

The minimum hard disk required is 15 GB. However, the recommended hard disk space for 
the server is 30 GB and above. 

Note: The network bandwidths recommended above are estimated according to the 
device numbers in four ranges. To calculate the network requirement for your specific 
device number, see Appendix. 
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3.2.2 Requirements for Download Server  

You can either set up a separate download server or use an existing download services 
provided by a Content Delivery Network (CDN) operator, a cloud based download server, 
etc.  

The download server you choose will affect the download performance. For information on 
how to improve the download performance, see Appendix. 

Note: The download feature you use must support HTTP or HTTPS download. 

If you choose to use an existing download service, make sure that the service provider offers 
stable download functions and you can skip this chapter.  

If you want to set up your own download server, make sure that the following requirements 
are met. 

Online 
devices 

Requirement Recommended configuration Minimal configuration 

< 10K 
Hardware 

CPU: 1 x Intel® Xeon®, 2 cores 
Memory: 4 GB 

CPU: 1 x Intel® Xeon®, 2 cores 
Memory: 4 GB 

OS Linux or Windows Linux or Windows 

Network 
bandwidth 
(Mbps) 

6  3  

10-50K 
Hardware 

CPU: 1 x Intel® Xeon®, 2 cores 
Memory: 4 GB 

CPU: 1 x Intel® Xeon®, 2 cores 
Memory: 4 GB 

OS Linux or Windows Linux or Windows 

Network 
bandwidth 
(Mbps) 

26  13  

50-
100K 

Hardware 
CPU: 1 x Intel® Xeon®, 4 cores 
Memory: 8 GB 

CPU: 1 x Intel® Xeon®, 2 cores 
Memory: 8 GB 

OS Linux Linux 

Network 
bandwidth 
(Mbps) 

43  21  

100-
200K 

Hardware 
CPU: 1 x Intel® Xeon®, 4 cores 
Memory: 12 GB 

CPU: 1 x Intel® Xeon®, 4 cores 
Memory: 8 GB 

OS Linux Linux 

Network 
bandwidth 
(Mbps) 

74  37  

 

Note: The network bandwidths recommended above are estimated according to the 
device numbers in four ranges. To calculate the network requirement for your specific 
device number, see Appendix. 
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3.3 Requirements for Hierarchized Architecture 

This section introduces the requirements for deploying the server in the hierarchized 
architecture. The architecture requires deploying the concentrative server on the Internet 
and deploying the school server on LAN in schools. The scenario assumes that the number of 
devices to be managed is more than 5K.  

The hardware and network requirements for the servers are 

 The requirement for concentrative TD server and separate download server are similar 
as that in Centralized architecture. 

 The requirement for school server is same as that in Decentralized architecture. 

 

Except these requirements, the limitation for one Sponsor server architecture is:  

 Total school server number < 500 

 Total device number (including the devices directly connect with Sponsor server and 
those belong to Proxy server) < 1M 

 Total device number directly connect to one server < 200K 

So if your totally deployment scalability is larger than the limitation, need consider deploy 
several Sponsor servers in parallel. 

3.4 General Requirements 

3.4.1 Operating System Requirements  

The server supports the following operating systems: 

 Windows: Windows Server 2008 R2 64-bits 

 Linux: Debian 6.0.3 64-bits/32-bits and above. You can find this operating system 
from the Debian official website. 

3.4.2 Domain Name Requirement 

For centralized and hierarchized architecture, the servers or the central server are hosted on 
the Internet. Therefore, it is recommended that you configure a static domain name for the 
servers. 

3.4.3 Security Guideline 

The server is the root of trust for all devices in the Theft Deterrent solution. Once deployed, 
it is the responsibility of the IT admin to protect the server against unauthorized use or 
online attacks. Therefore, it is strongly recommended that you follow these guidelines to 
protect the server: 

Physical security: 

 Lock the machine in the cabinet and deny unauthorized personnel from physically 
accessing the server. 

Network security: 

 Install firewall, IPS, etc. 

http://www.debian.org/CD/http-ftp/#mirrors


Intel® Education Theft Deterrent Deployment Guide Revision 1 

- 14 -  

Operating system security: 

 Configure the security settings of the operating system. 

 Update the operating system and install security patches regularly. 

 Close all the services not necessary for the server or restrict the services to be 
available only to internal IP. For example, the remote desktop/VNC. 

Operating System administrator security: 

 Secure the admin/root account of the operating system.  

 Do not change the access permissions of the configuration files and keystore files, 
which are set to read only and accessible by admin/root account only by default. 

 Do not add unnecessary account to the operating system or open guest accounts. 

Theft Deterrent account security: 

 Keep the passwords of the database server account and the database administrator 
account secure.  

 If the database server is deployed on a separated machine, keep the machine in the 
internal network and configure the database server to be accessible by the web 
server only.  

 Keep the user account passwords of the server secure. For example, require users to 
change their passwords frequently and never share their passwords with anyone. 

General security： 

 The server admin and other users should not log in the server from a public or 
shared computer. Also, it is recommended that you close all other websites when 
logged in the server. 

 The server admin and other users must not misuse the server. 

Device security (activation and check-in): 

 It is recommended that you activate the devices in factory. The devices are 
protected by the Theft Deterrent solution only after activation completes. 

 Guarantee that the devices can check in with the server. 

Note: It is highly recommended that you do not install any unrelated software on the 
server machine. 

If you cannot keep the server security or all the devices have good Internet 
connection, you can choose Intel cloud services. 

3.4.4 Other Requirements 

Also, if you have installed a server earlier than version 3.x (including 3.x) on the system, it is 
highly recommended that you uninstall this server and its dependencies (Tomcat and 
PostgreSQL) before installing the current server to avoid port conflict.  

However, if you want to keep the earlier version of the server, you must stop its 
dependency, Tomcat, while installing and running the current server. 
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4. Deploy Theft Deterrent server on Debian 

This chapter introduces the procedures to deploy the server on Debian.  

The deployment steps install the download feature as part of the web service by default. If 
you want to use a separate download server, complete the following deployment steps and 
then configure the server to use the separate download server with the steps in chapter 7.  

4.1 Install Dependencies 

You must install the following dependencies on your Debian system before installing the 
server: 

Dependency Version 

sudo >=1.7 

Ufw >=0.2 

Python >=2.6 

Dialog >=1.0 

 

To install the dependencies, follow these steps: 

Note: Connect the machine to the Internet or use the Debian CD to 
install the dependencies.  

1. Change to root account with the following command. Input password when needed: 

su - 

2. Open the sources list located at /etc/apt/sources.list and add the 
following lines.  Replace [release] with the Debian release version. 

deb http://cdn.debian.net/debian/ [release] main 
deb-src http://cdn.debian.net/debian [release] main 

3. Update the sources list with the following command: 

apt-get update 

4. Install dialog with the following command: 

apt-get install dialog 

4.2 Install Theft Deterrent server 

Copy the server installation package (Theft_Deterrent_server_v4.0.3010X.[version]) to any 
folder in the local disk. Go to the folder and then run the following commands: 

1. Change to root account and input password when needed: 

su - 

2. Change the file permission of the installation package: 

http://www.debian.org/releases/index.en.html
http://cdn.debian.net/debian/
http://cdn.debian.net/debian
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chmod +x Theft_Deterrent_server_v4.0.3010X.[version] 

3. Run the installation package to open the install wizard: 

./Theft_Deterrent_server_v4.0.3010X.[version] install 

Follow these steps to deploy the server: 

4. Select the language of your choice and then select Next. Press Enter. 
5. Press Enter to accept the license agreement. 
6. Select the Local database option and then select Next. Press Enter.  

Figure 7 - Database Location 

 

7. Set a password for the database server. Select Next and then press Enter. 
8. Select a server support mode of your choice and then select Next. Press Enter.  

Figure 8 - Server Support Mode 

 

9. If you choose to install the Stand-alone mode, select select the Root Public Key type for 
your deployment on the next page. 
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Figure 9 - Select Root Public Key Type (Stand-alone Mode) 

 

10. If you choose to deploy the server with your own Root Public Key, you must import the 
Root Public Key file (with the extension .pubkey or .bin) by copying the key to your local 
machine and then inputting the location of the key in the following window. (e.g. 
/opt/CmpcRoot.pubkey)  

Figure 10 - Import Root Public Key (Stand-alone Mode) 

 

Note: In the install wizard, use Tab or arrow keys to move between the windows. 
Within the directory or filename windows, use the up or down arrow keys to scroll the 
current selection.  Use the Space bar to confirm the selection. 

11. On the next step, set a password and email for the master admin account. Select Next 
and then press Enter. 

12. On the next step, specify your HTTP and HTTPS ports if you want to change or select 
Next to use default value (80 for HTTP and 443 for HTTPS). 
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Figure 11 - Select Network Ports 

 
13. Confirm the settings and then select OK. Press Enter. 
14. Wait for the installation to complete.  
15. After completion, you can select OK exit and automatically start TheftDeterrent Server, 

or select Exit without start the server to finish installation without TD service 
automatically start after system boot up. 

Figure 12 – Select Service Automatically Start 

 

Note: The password must be 8 to 30 characters in length and must contain at least 
one lowercase letter [a-z], uppercase letter [A-Z], number [0-9], and special character. 
It must not contain sequences of the same character (e.g. aa, 33, ##) or numbers that 
are longer than 5 characters (e.g. 12345, 67890). 

To deploy the server with a separate database, contact the Intel local TME for support. 

4.3 Best Practice of Performance Tuning 

The default configuration of the server has limited the resource assignment, which could be 
a bottleneck for the server performance. To improve the performance of the server, you can 
tune the database service, web service, log, and download service with the perfconfig tool.  

If your server is deployed on LAN and manages less than 5K online devices, no tuning step is 
required and you can skip this chapter. 

Otherwise, improve server performance with the following steps: 
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1. Run the following commands with root privilege to start the perfconfig tool: 

cd /opt/Theftdeterrentserver/bin 
./perfconfig 

2. Select a language of your choice. 

 
3. Select the number of online devices that your server will manage. 

 
4. You might also need to configure the following settings: 

 Is your server deployed on LAN or the Internet? 

 
 Input the individual download speed limit (KB/s): Set a download limit for the local 

download feature. This setting will not affect any separate download server. 
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 How many log files you want to save? 

 

5. Input 1 and press ENTER to restart the web service. 

 

4.4 Upgrade Theft Deterrent server 

You can upgrade the server from version 4.x to a higher version. All the data and settings of 
the server are kept after the upgrade. Before upgrading, it is recommended that you back up 
the server.  

 

There are two kinds of upgrade package:  

1. Upgrade only the TDserver itself without 3rd party dependency, using package named as 
Theft_Deterrent_server-upgrade_v4.0.3010X.[version] can be used for the size is much 
smaller than full installer package. 

2. Upgrade both the TDserver and 3rd party dependency, using the installer package 
Theft_Deterrent_server_v4.0.3010X.[version] for the upgrade. 

 

To upgrade a TDserver without 3rd party dependency, follow these steps: 

1. Copy the latest server upgrade package (named as Theft_Deterrent_server-
upgrade_v4.0.3010X.[version]) to the local disk.   

2. Open the installation wizard by following the steps. 

./Theft_Deterrent_server-upgrade_v4.0.3010X.[version] install 

3. Select a language of your choice and accept the license agreement. 
4. Then wait for the wizard to complete the upgrade. 
5. Clear cache of your browser before login to server again. 

 

To upgrade a TDserver with 3rd party dependency, follow these steps: 
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1. Copy the latest server upgrade package (named as Theft_Deterrent_server-
upgrade_v4.0.3010X.[version]) to the local disk.   

2. Open the installation wizard by following the steps. 

./Theft_Deterrent_server_v4.0.3010X.[version] install 

3. Select a language of your choice and accept the license agreement. 
4. On the next page, select Upgrade or Repair to upgrade with keep all data. 
5. Follow the installation wizard to complete the upgrade for TDserver and 3rd party 

dependency. 
6. Clear cache of your browser before login to server again. 
 

Note: The browser will cache old server and make the webpage display maybe distort 
after server upgrade. 

Figure 13 - Upgrade Theft Deterrent server 

 

4.5 Repair or Re-install Theft Deterrent server 

If upgrade failed, the current server may be corrupted. You can repair the server with the 
current installation package. And you can reinstall the server to remove the server data, 
settings and key files.  Before repair or re-install, it is recommended that you back up the 
server.  

To repair or re-install a server, follow these steps: 

1. Copy the latest serve install package (Theft_Deterrent_server_v4.0.3010X.[version]) to 
the local disk.   

2. Open the installation wizard by following the steps in chapter 4.2. 

./Theft_Deterrent_server_v4.0.3010X.[version] install 

3. Select a language of your choice and accept the license agreement. 
4. On the next page, select Upgrade or Repair to keep all data and Re-install to remove all 

data of your current server. 
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Figure 14 - Repair or Re-install Theft Deterrent server 

 

5. Follow the installation wizard to complete the installation. 

4.6 Uninstall Theft Deterrent server 

If you want to uninstall the server, it is recommended that you back up the server before the 
action. 

Note: Make sure that no device is managed by the server any more. Otherwise, the 
devices might be locked within a certain period of time. 

To uninstall the server, follow these steps: 

1. Go to the directory that contains the server installation package. 
2. Run the following command with root privilege to uninstall the server. 

./Theft_Deterrent_server_v4.0.3010X.[version] remove 
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5. Deploy Theft Deterrent server on Windows 

This chapter introduces the procedures to deploy the server on Windows.  

The deployment steps install the download feature as part of the web service by default. If 
you want to use a seperate download server, complete the following deployment steps and 
then configure the server to use the third-party download server with the steps in chapter 7. 

5.1 Install Theft Deterrent server 

Copy the server installation package (Theft_Deterrent_server_v4.0.10000.[version].zip) to 
the local disk and then extract the installation package into a temporary folder. In the 
temporary folder, right-click setup.exe and select Run as administrator to open the 
installation wizard. 

Follow these steps to deploy the server: 

1. Select a language of your choice and then click OK. 

Figure 15 - Choose language 

 
2. Accept the license agreement and then click Next. 
3. Select Local Database and then click Next. 

Figure 16 - Database Location 

 
 

4. Set a password for the database server and then click Next. 
5. Select a server support mode of your choice and then click Next. 



Intel® Education Theft Deterrent Deployment Guide Revision 1 

- 24 -  

Figure 17 - Server Support Mode 

 

6. If you choose to install the Stand-alone mode, select the Root Public Key type for you 
deployment on the next page.  

Figure 18 - Stand-alone Mode 

 

7. If you choose to deploy the server with your own Root Public Key, you must import the 
Root Public Key file (with the extension .pubkey or .bin) by copying the key to your local 
machine and then browse to the location of the key. (e.g. C:\CmpcRoot.pubkey)  
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Figure 19 - Import Root Public Key (Stand-alone Mode) 

 

8. On the next step, set a password and email for the master admin account and then click 
Next. 

9. Confirm the settings and then click Install. 
10. The installation will be completed in about 20 minutes.  

Note: The password must be 8 to 30 characters in length and must contain at least 
one lowercase letter [a-z], uppercase letter [A-Z], number [0-9], and special character. 
It must not contain sequences of the same character (e.g. aa, 33, ##) or numbers that 
are longer than 5 characters (e.g. 12345, 67890). 

To deploy the server with separate database, contact the Intel local TME for support. 

5.2 Best Practice of Performance Tuning 

If your server is deployed on LAN, no tuning step is required and you can skip this chapter. 

If your server is deployed on the Internet, improve the performance of your server with the 
following steps because the default configuration of the server has limited the resource 
assignment, which could be a performance bottleneck. 

5.2.1 Common Configuration  

Configure the performance options in Windows with the following steps: 

1. From Windows desktop, click the Start menu -> Control Panel -> System and Security -> 
System -> Advanced system settings. 

2. On the popup window, switch to the Advanced tab and click Settings in the 
Performance area. 

3. In the Visual Effects tab, select the Adjust for best performance option as shown below 
and then click Apply. 
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Figure 20 - Configure Performance (1) 

 

4. Switch to the Advanced tab, select Background services in the Processor scheduling 
area and then click OK. 

Figure 21 - Configure Performance (2) 

 

Enable Write-caching for hard disks with the following steps: 
5. From Windows desktop, click the Start menu-> Control Panel -> Hardware -> Device 

manager.  
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6. Double-click Disk drivers in the Device Manager window. 
7. Right-click the hard disk device where the server is installed and select Properties.  
8. On the popup window, click on the Polices tab and check Enable write caching on the 

device. Then click OK.  

Figure 22 - Configure Performance (3) 

 

Add the server URL to Trusted sites with the following steps: 

9. On Internet Explorer, click Tools -> Internet Options -> Security Tab. 
10. On the Security page, select Trusted Sites and click the Sites button. 
11. On the popup window, input https://localhost/ and then click the Add button. 

Figure 23 - Add Trusted Sites 

 

12. Click Yes on the confirmation window. Click Close. 
13. Make sure that the security level for Trusted sites is Medium and then click OK. 

https://localhost/
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Figure 24 - Configure Security Level 

 

5.2.2 Tune the Performance 

The default configuration of the server has limited the resource assignment, which could be 
a bottleneck for the server performance. To improve the performance of the server, you can 
tune the database service, web service, log, and download service with the perfconfig tool. 

If your server is deployed on LAN and manages less than 5K online devices, no tuning step is 
required and you can skip this chapter. 

Otherwise, improve server performance with the following steps: 

1. Run the following commands with admin privilege to start the perfconfig tool: 

cd C:\Program Files\Intel Education Software\Theft Deterrent server\bin 

 

call perfconfig.bat 

2. Select a language of your choice. 
3. Select the number of online devices that your server will manage. 
4. You might also need to configure the following settings: 

 Is your server deployed on LAN or the Internet? 

 Input the individual download speed limit (KB/s): Set a download limit for the local 
download feature. This setting will not affect any separate download server. 

 How many log files you want to save? 

5. Input 1 and press ENTER to restart the server. 

5.3 Upgrade Theft Deterrent server 

If upgrade failed, the current server may be corrupted. You can repair the server with the 
current installation package. Before repair or re-install, it is recommended that you back up 
the server.  
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There are two kinds of upgrade package:  

1. Upgrade only the TDserver itself without 3rd party dependency, using package named as 
Theft_Deterrent_server-upgrade_v4.0.10000.[version] can be used for the size is much 
smaller than full installer package. 

2. Upgrade both the TDserver and 3rd party dependency, using the installer package 
Theft_Deterrent_server_v4.0.10000.[version] for the upgrade. 

 

To upgrade a TDserver without 3rd party dependency, follow these steps: 

1. Copy the latest server upgrade package (named as Theft_Deterrent_server-
upgrade_v4.0.10000.[version].zip ) to the local disk then extract the installation package 
into a temporary folder. In the temporary folder, right-click setup.exe and select Run as 
administrator to open the installation wizard. 

2. Select a language of your choice and accept the license agreement. 
3. Then wait for the wizard to complete the installation. 
4. Clear cache of your browser before login to server again. 

To upgrade a TDserver with 3rd party dependency, follow these steps: 

1. Copy the latest server upgrade package (named as Theft_Deterrent_server-
upgrade_v4.0.10000.[version].zip ) to the local disk then extract the installation package 
into a temporary folder. In the temporary folder, right-click setup.exe and select Run as 
administrator to open the installation wizard. 

2. Select a language of your choice and accept the license agreement. 
3. On the next page, select Upgrade or Repair to upgrade with keep all data. 
4. Follow the installation wizard to complete the upgrade for TDserver and 3rd party 

dependency. 
5. Clear cache of your browser before login to server again. 

Figure 25 – Upgrade Theft Deterrent server 

 

Note: The browser will cache old server and make the webpage display maybe distort 
after server upgrade. 
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5.4 Repair or Re-install Theft Deterrent server 

If upgrade failed, the current server may be corrupted. You can repair the server with the 
current installation package. And you can reinstall the server to remove the server data, 
settings and key files.  Before repair or re-install, it is recommended that you back up the 
server.  

To repair or re-install a server, follow these steps: 

1. Copy the latest server upgrade package (named as Theft_Deterrent_server 
_v4.0.10000.[version].zip ) to the local disk then extract the installation package into a 
temporary folder. In the temporary folder, right-click setup.exe and select Run as 
administrator to open the installation wizard. 

2. Select a language of your choice and accept the license agreement. 
3. Select Upgrade or Repair to keep all data and Re-install to remove all data of your 

current server. 

Figure 26 – Repair or re-install Theft Deterrent server 

 

4. Follow the installation wizard to complete the installation. 

5.5 Uninstall Theft Deterrent server 

If you want to uninstall the server, it is recommended that you back up the server before the 
action. 

Note: Make sure that no device is managed by the server any more. Otherwise, the 
devices might be locked within a certain period of time. 

You can uninstall the server by using either the installation package or the Control Panel. 

To uninstall the server with the installation package, follow these steps: 

1. Open the folder that contains the installation package.  
2. In the folder, right click setup.exe and select Run as administrator to open the uninstall 

wizard. 
3. Click Next on the welcome page. Click Next. 
4. Click Remove to uninstall the server. 
5. Wait for the process to complete and then click Finish.  
6. Reboot the system. 
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To uninstall the server from the Control Panel, follow these steps: 

1. Click the Start menu -> Control Panel -> Programs -> Programs and Features. 
2. Right-click Intel(R) Education Theft Deterrent server and select Uninstall. 
3. Click Yes to confirm the action. 
4. Click Yes to reboot the system. 
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6. Theft Deterrent server Pre-configurations 

After server installation completes, you can use the server functionalities by accessing the 
server webpage with the following URL, where [serverURL] is the IP address or hostname of 
the server. 

 https://[serverURL]/TheftDeterrent 

To log in the server with the master admin account, use the following credentials: 

 The username is admin 

 The password is the one set during the installation process.  

6.1 First Time Configurations 

When you log in the server for the first time, you must complete certain settings before 
accessing the server functionalities. The settings differ according to the server support 
mode, which is set during the installation of the server. 

Server Support Mode First login settings 

Stand-alone mode  Set up Server Name & Address & Auto-backup 
strategy (Optional) 

 Set up Email Server (Optional) 

 Set up Root server address (Optional) 

Central Server supported  Activate  or reactivate  at Centre Server 

 Set up Server Name & Address & Auto-backup 
strategy (Optional) 

 Set up Email Server  (Optional) 

Proxy mode  Activate or reactivate at Sponsor server 

 Set up Server Name & Address & Auto-backup 
strategy (Optional) 

 Set up Email Server (Optional) 

 Edit Sync-up Schedule (Optional) 

6.1.1 Activate/Reactivate Proxy server at Sponsor Server 

If the server is installed with the Proxy mode, you must activate or reactivate the server with 
the sponsor server during first login.  

If the Proxy server has never been registered or activated on the Sponsor server, follow 
these steps to online activate the server: 

https://[serverURL]/TheftDeterrent
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Figure 27 – Activate Proxy Working flow 

 

1. In Proxy server, on the Activate Theft Deterrent server page for Register, input proxy 
server information and IP address of the sponsor server. Click Register Server and your 
activation request will be sent to the sponsor server.  

Figure 28 - Register Server 

 

2. In Sponsor server, choose Servers->Pending Approvals. Select the proxy that you want 
to approve, and click Accept Proxy Server.  

Figure 29 - Pending approvals 

 
3. In Sponsor server, copy the Activation Code generated and send the Activation Code to 

Proxy server by email or offline. 
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Figure 30 - View activation code 

 
4. In Proxy server, inputs the activation code and Sponsor server address to activate the 

proxy server. 
Figure 31 - Activation on Sponsor Server 

 
5. When you see the activation success message, click OK. 
 

Except the online register/activation, you can do the offline register/activation through 
these steps if no connectivity between central server and TD server: 

1. In TD server, click the Register offline to export the offline registration package 

2. In Sponsor server, import the Offline registration package and export the offline 
activation package 

3. In TD server, click Activation offline and import the offline activation package to finish 
the activation process. 

 
If want to crash recovery an activated Proxy server with a new installed Proxy server, follow 
these steps to reactivate the server: 
1. In Sponsor server, click Servers->Proxy Servers and click the proxy server that is going 

to be reactive. In detail page, click Re-activate Server. Then the server will be moved 
under Servers -> Pending Approvals as Re-activating Status. 
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Figure 32 – Re-activate and Get Activation Code 

 

 
2. In Proxy server, On the Activate Theft Deterrent server page for Register, click Re-

activate. On the Re-activate Theft Deterrent server page, input the Activation code and 
the URL for Sponsor server. Then click Re-activate Server. 

Figure 33 - Reactivate server 

 
3. When you see the reactivation success message, click OK. 

6.1.2 Activate/Reactivate at Central Server 

If the server is installed with the Central Server supported mode, you must activate or 
reactivate the server with the Central server during first login. The Central server can be a 
legacy Central server in 3.x or a TDv3 server 4.5.x in Sponsor mode running as a Central 
server. 

Requirements: 
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 If activate it in Central server: make sure that the central server is connected with the 
Root CA server, keep connection between TD server and Central server 

 If activate it in Sponsor server: make sure the Sponsor server set the Root CA server 
address and is connected with the Root CA server, keep connection between TD server 
and Sponsor server. 

If the server has never been registered or activated on the central server, follow these steps 
to activate the server: 

 

1. On the Activate Theft Deterrent server page (Step 1), input all server information and 
the IP address of the central server.  

2. Click Register Server and your activation request will be sent to the central server.  
Figure 34 - Activate Server  

 

3. When your request is approved by the central server admin, you will receive an 
activation code. The approval process might take a while and you can log out of the 
server during this period. 

4. After you receive the activation code, log in the server and click Register Server on the 
Activate Theft Deterrent server page (Step 1). You can skip this step if you did not log 
out the server. 

5. On the Activate Theft Deterrent server page (Step 2), input the activation code and the 
IP address of the central server. Then click Activate Server. 

6. When you see the activation success message, click OK. 
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Except the online register/activation, you can do the offline register/activation through 
these steps if no connectivity between central server and TD server: 

1. In TD server, click the Register offline to export the offline registration package 

2. In Central server, import the Offline registration package and export the offline 
activation package 

3. In TD server, click Activation offline and import the offline activation package to finish 
the activation process. 

 

If you had already activated a server that later crashed and its key pair are lost permanently, 
you can replace the crashed server by installing a new server with the Central Server 
supported mode.  

Follow these steps to reactivate at Central server: 

1. Contact central server admin offline to request an activation code for reactivation. 
2. On the Activate Theft Deterrent server page (Step 1), click Skip. 
3. On the Activate Theft Deterrent server page (Step 2), input the activation code and the 

IP address of the central server. Then click Reactivate Server. 
4. When you see the reactivation success message, click OK. 

6.1.3 Set up Server Name & Address & Auto-back Strategy 

Server name 

 Server name must be less than 128 characters in length.  

 If the server is installed with the Central Server supported mode, the server name is 
already set during the activation process.  

Server IP address/ URL 

 Server address is the IP address or URL of the server machine. 

 This server address will be broadcasted to the clients when the Automatic Server 
Broadcast function is turned on in LAN. 

Auto-backup strategy 

 Turn on/off for the auto-backup policy. 

 Interval for the auto-backup policy 

6.1.4 Set up E-mail Notification Service 

You can set up the e-mail service to send user account and server information to users via e-
mail. Input the following information: 

 E-mail username: the e-mail address of your e-mail account 

 E-mail password: the password of your e-mail account 

 SMTP server: the hostname of the SMTP server.  

 Port: the port number of the SMTP server.  

 Security Mode: select a security mode. 
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Figure 35 - Set up E-mail Notification Service 

 

After the email service is configured correctly, the server will send out e-mails in the 
following cases: 

When to send e-mails? Recipient 

Admin creates new user accounts The new user 

Admin resets user passwords The user 

Someone forgets his/her password and requests 
password reset  

The person him/herself 

Someone sets up the E-mail Notification function The e-mail addresses that this person 
configured for the function 

 

After you complete the first login settings, you will see the server Home page. You can also 
open the Inventory, Groups & Accounts, Servers (only for Sponsor server) and Settings 
pages to access different functions. 

Figure 36 - Server Tabs for Sponsor server 

 

6.1.5 Set up Root server address 

If you install a server in Standalone mode, and this server may manage the non-Proxy server 
in future, it is highly recommended you setup the Root server Address after first login.  

You can access the Root server address setting in Settings -> Advanced tab. 

Figure 37 - Set Up Root Server Address 
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6.1.6 Set up Sync-up Schedule 

After Proxy server activated, the sync-up schedule is initialized to a random time with daily 
frequency. It is highly recommended you can set the regular fully sync-up frequency 
according to your network situation. 

You can access the Server Sync-up setting in Settings -> Server tab. 

Figure 38 - Set Up Sync-up Schedule 

 

6.2 Modify the Server Log Level 

By default, the server is set with the DEBUG log level to log all precise contexts concerning 
its running status in case any error occurs and requires debugging.  

The log levels affect the server performance as follows: 

Log Level Server Performance Information Detail 

DEBUG Low High 

INFO Medium Medium 

WARN High Low 

 

If you are experiencing slow server performance, it is recommended that you lower the 
server log level with the following steps. Otherwise, you can skip this chapter.  

1. Open the log configure file: 

 Debian: /opt/TheftDeterrentserver/Site/webapps/TheftDeterrent/WEB-
INF/classes/log4j.properties 

 Windows: %SystemDrive%\Program Files\Intel Education Software\Theft 
Deterrent server\Site\webapps\TheftDeterrent\WEB-
INF\classes\log4j.properties 

2. Set the log level to INFO or WARN by changing a line in the configure file as follows: 

log4j.logger.com.intel=INFO 

or 

log4j.logger.com.intel=WARN 

3. Restart the server: 

 Debian: run the following command: service theftdeterrentserver restart 

 Windows: click the Start menu -> All Programs -> Intel Education Software -> Theft 
Deterrent server -> Start Server. 
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6.3 Server Installation Directories and Log Files 

While using the server, make sure that you follow these rules: 

 On both Windows and Debian, do not change the access permission to the 
installation directories. 

 On Windows, do not access the installation directories with a standard user account 
by inputting the administrator password when prompted by Windows User Account 
Control. 

The installation directories of the server are as follows: 

Windows:  

 %SystemDrive%\Program Files\Intel Education Software\Theft Deterrent 
server 

 %SystemDrive%\ProgramData\TheftDeterrent2 

Debian: 

 /opt/TheftDeterrentserver 

 /etc/TheftDeterrent2 

The location of the binary files and log files are as follows: 

Operating 
System 

Linux Windows 

Shortcut /usr/local/theftdeterrentserver Start menu -> Intel Education 
Software -> Theft Deterrent server 

Log folder /var/log/theftdeterrentserver 

/opt/TheftDeterrentserver/Site/
logs 

%systemdrive%\log\theftdeterren
tserver 
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7. Use Separate Download Server 

To use a separate download server for your server, you must first complete the deployment 
steps in chapter 4 or 5 and the pre-configuration steps in chapter 6. Then configure the 
server to use the separate download server. 

You can either set up a separate download server or use an existing download services 
provided by a CDN operator, a cloud based download server, etc. If you want to set up your 
own download server, see Configure Download Server. 

7.1 Configure Download Server 

The deployment or configuration steps of the third-party download server are beyond the 
scope of this document. You can contact your third-party server provider for support.  

However, if you have not decided which third-party download server to use, you can install 
another Theft Deterrent server to function as a download server with the following steps: 

1. Install another Theft Deterrent server on a machine that meets the download server 
requirements. 

2. Copy the client upgrade packages to the following location manually, according to your 
operating system: 

 Windows: C:\Program Files\Intel Education Software\Theft Deterrent 
server\Site\webapps\tdupdate 

 Debian: /opt/TheftDeterrentserver/Site/webapps/tdupdate 

Note: To obtain a client upgrade package, which ranges from 2MB to 10MB in size, 
contact the Intel local TME. 

Connect this download server to the same network as the server. 

7.2 Configure Download Feature on Theft Deterrent server 

When the download server is ready, configure the server to use the download server with 
the following steps: 

1. Log in the server and open the Advanced page under Settings.  
2. Click the Configure download server(s) link in the Smart Client Upgrade area. 
3. Input the following information: 

 Server Name: the name of the download server. 

 URL: the location of the upgrade packages in the download server, which must be in 
HTTP scheme. For example, if you use another Theft Deterrent server as the 
download server, the URL is http://[DownloadServer URL]/tdupdate/ 

Note: This URL is provided to clients for downloading upgrade packages when the 
Smart Client Upgrade function is enabled. However, you must copy the upgrade 
packages to your download server manually.  

 Concurrent Download Limitation: the maximum number of devices that can 
download the upgrade packages at the same time. 
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 Client Speed Limitation: the maximum network speed for a device to download the 
upgrade packages.  

4. Click the Save Button. 

You can configure multiple download servers. However, it is recommended that you keep 
the maximum number of download servers below 15. 

You can select one or multiple download servers to implement the download function at the 
same time. The local server is the local download feature provided by default.  

Note: When you add, edit, or delete a download server, the configuration takes effect only 
after you click the Save button. 

Figure 39 - Configure Download Server 

 

For more information on how to configure the separate download server, contact your local 
TME for support. 
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8. Manually Deploy Theft Deterrent client and 
guardian 

The client and the Theft Deterrent guardian (guardian) are Theft Deterrent components that 
run on devices. The client can lock and unlock devices based on the certificates received 
from the Theft Deterrent server while the guardian is a client protection application that 
restores the client if it is uninstalled or disabled. 

Both components support the following operating systems: 

 Windows 7 or 8 

 Debian 7 32-bits 

 Debian 7 64-bits 

 Android 

The client and guardian are usually preloaded in factory during the manufactory of the 
devices. If your device is not preloaded with a client or guardian, you can deploy the 
components manually. As a best practise, the client should be kept running at all times. 
Therefore, for each client deployed, you must deploy a guardian on the same device.  

This chapter introduces the steps to deploy the client and guardian on devices running the 
Windows or Debian operating system. For all devices running the Android operating system, 
the client and guardian are always preloaded and thus would not require manual 
deployment. 

Note: The device’s TPM must be initialized in manufactory line before you deploy the 
client and guardian or the components will report error. 

8.1 Deploy Theft Deterrent client and guardian on Windows 

For devices running the Windows operating system, the installation package 
(Theft_Deterrent_client_guardian_[version].zip) supports two deployment methods: 

 Command line, which Installs client and guardian together. 

 Install wizards, which Install client and guardian separately. 

For large deployments, it is recommended that you use the command line to install the 
client and guardian. Such deployment provides efficiency because the two components are 
deployed together while no user interaction is required during the process. 

If you are deploying on a single device, you can use the install wizards, which are more user-
friendly.  

8.1.1 Prerequisite 

Before you install the client, you must install .Net 3.5 SP1 on the Windows operating system 
if not already installed.  

 For Windows 7, you can install .Net 3.5 SP1 either by turning on the feature in 
Windows Feature or by downloading and installing the package from Microsoft 
website. 

 For Windows 8, download and install .Net 3.5 SP1 from Microsoft website. 

http://www.microsoft.com/en-us/download/details.aspx?id=22
http://www.microsoft.com/en-us/download/details.aspx?id=22
http://www.microsoft.com/en-us/download/details.aspx?id=22
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8.1.2 Install with Command Line 

To install the client and guardian with command line, follow these steps: 

1. Extract the installation package (Theft_Deterrent_client_guardian_[version].zip) into a 
temporary folder, for example, C:\TD. 

2. Click the Start menu -> Accessories -> right-click Command Prompt -> select Run as 
administrator. 

3. Go to the bin folder in the temporary folder with a command such as the following:  

cd c:\TD\bin 

4. Run install.bat. 

install.bat 

The device will restart automatically once the installation completes. The client displays the 
language of the operating system  

If the display language of the operating system is English, Portuguese, Turkish, or Spanish, 
the client follows the same display language. Otherwise, the client is displayed in English. 

8.1.3 Install with Install Wizard 

To install the client with the install wizard, follow these steps: 

1. Extract the installation package (Theft_Deterrent_client_guardian_[version].zip) into a 
temporary folder. 

2. In the temporary folder, open the agent folder under bin, right-click setup.exe, and 
select Run as administrator to open the installation wizard. 

3. Select a language of your choice and then click OK. 
4. Click Next on the welcome page. 
5. Set the protection password for the client and then click Next. If you do not want to set 

the password, leave the password field blank, click Next and then click OK on the 
confirmation window. 

6. Click Next to start the installation. This might take a few minutes.   
7. When the installation completes, click Finish.  
8. Click Yes on the popup window to reboot the system. 

Note: The protection password must be 6 to 30 characters in length and must contain 
at least one uppercase letter [A-Z], one lowercase letter [a-z], one number [0-9], and 
one special character. If you set up the protection password during the installation, 
the password is required when you change the client settings or uninstall the client. 
The protection password can be reset by the server admin. 

 

To install the guardian with the install wizard, follow these steps: 

1. Extract the installation package (Theft_Deterrent_client_guardian_[version].zip) into a 
temporary folder. 

2. In the temporary folder, open the guardian folder under bin, right-click setup.exe, and 
select Run as administrator to open the installation wizard. 

3. Select a language of your choice and then click OK. 
4. Click Next on the welcome page. 
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5. Set the protection password for the client and then click Next. If you do not want to set 
the password, leave the password field blank, click Next and then click OK on the 
confirmation window. 

6. Click Next to start the installation. This might take a few minutes.   
7. When the installation completes, click Finish.  
8. Click Yes on the popup window to reboot the system. 

Note: The protection password must be 6 to 30 characters in length and must contain 
at least one uppercase letter [A-Z], one lowercase letter [a-z], one number [0-9], and 
one special character. This protection password will replace the password set during 
the client installation. 

8.2 Deploy Theft Deterrent client and guardian on Debian 

8.2.1 Install Dependency 

You must install dbus on your Debian 7 operating system if not already installed. To install 
dbus, follow these steps: 

Note: Connect the machine to the Internet or use the Debian CD. 

1. Change to root account with the following command. Input password when needed: 

su - 

2. Install dbus with the following command: 

apt-get install dbus wireless-tools dmidecode 

8.2.2 Install Theft Deterrent client and guardian with full package 

If you have the release package named as Theft_Deterrent_client_guardian_[version]. tar.gz, 
follow these steps to install: 

Copy the server installation packages (Theft_Deterrent_client_guardian_[version]. tar.gz) to 
any folder in the local disk. Go to the folder and then run the following commands with root 
privilege: 

1. Change to root account with the following command. Input password when needed: 

su - 

2. Extract the installation package into a temporary folder, for example, /tmp, with a 
command such as the following: 

tar -zxvf install.tar.gz -C /tmp 

3. Go to the bin folder in the temporary folder: 

cd /tmp/bin 

4. Run the installation script: 

chomd a+x install.sh 
./install.sh [language] 

Replace [language] with one of the following values to assign a display language for the 
client. The default display language is English. 
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8.2.3 Install Theft Deterrent client and guardian with separately package 

If you have 3 separately  release package, follow these steps to install: 

1. Copy the three installation packages to any folder in. ( e.g., /tmp/) : 

 Theft_Deterrent_client_[version].zip 

 Theft_Deterrent_guardian_[version].zip 

 theftdeterrentclient-lib_[version].deb 

2. Change to root account with the following command. Input password when needed: 

su - 

3. Go to the folder containing the installation package. For example, 

cd /tmp 

4. Install client dependence libraries: 

dpkg -i theftdeterrentclient-lib_[version].deb 

5. Unzip client and Install client with specific language: 

unzip Theft_Deterrent_client_[version].zip 
./Theft_Deterrent_client_[version] install [language] 

6. Unzip the guardian and Install guardian: 

unzip Theft_Deterrent_guardian_[version].zip 
./Theft_Deterrent_guardian_[version] install 

 

Note: [language] table refer to below: 

Values Language 

en-US English 

pt-BR Portuguese 

tr-TR Turkish 

es-MX Spanish 

  

After installation completes, the client is opened automatically.  

8.3 Pre-set server address and address modify protection 
password 

The server address can be preset in master image, so all the client will have the server 
address before it shipped out to end customer.  

A password to protect the server address being changed can be preset in the master image 
as well. This password will be reset to the protection password in server setting once after 
the client connects with the server. 
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Item Windows method Linux method Android method 

Server address In Master image: edit the address and 
Save. 

A file named as  tdip.txt 
under sdcard/ 

Address protection 
password 

Set during install 
process 

1. Generate a password encryption file - 
passwordPro.ini   

 

2. Copy the passwordPro.ini under the 
client install path. 

 

8.4 Open Theft Deterrent client 

The client and guardian are loaded automatically at system start-up. You can open the client 
from either the client tray icon or the shortcut according to your operating system. For more 
information on how to use the client, see the Intel® Education Theft Deterrent client User 
Manual. 

8.4.1 Open Theft Deterrent client on Windows 

If your operating system is Windows 7, you can open the client with either of the following 
methods: 

 Click the Theft Deterrent client application icon  on the desktop.  

 Right-click the client tray icon and select Open Theft Deterrent client. 

If your operating system is Windows 8, you can open the client with one of the following 
methods: 

 Click the Theft Deterrent client application icon  on the Start screen. 

 Click the Theft Deterrent client application icon  on the desktop.  

 Right-click the client tray icon on the desktop and select Open Theft Deterrent client. 

If the client is in Inactive status, right-click the client tray icon on the desktop and select Help 
for instructions on how to activate the client. 

Figure 40 – Client Inactive Tray Icon (Windows) 

 

8.4.2 Open Theft Deterrent client on Debian  

If your operating system is Debian 7, you can open the client by clicking the client tray icon 
on the upper-right corner of the desktop. If the client is in Inactive status, right-click the tray 
icon and select Help for instructions on how to activate the client. 
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Figure 41 – Client Inactive Tray Icon 

 

Note: The client tray icon is only supported in GNOME 3.4 or above. 

Also, if your Debian 7 displays the GNOME desktop, you can open the client by clicking 
Applications -> All -> the Theft Deterrent client icon. 

Figure 42 - Shortcut on GNOME  

 

If your Debian 7 displays the GNOME Classic desktop, you can open the client by clicking 
Applications -> System Tools -> Theft Deterrent client. 



Intel® Education  Theft Deterrent Deployment Guide Revision 1 

  - 49 - 

Figure 43 - Shortcut on GNOME Classic  

 

8.5 Installation Directories and Log Files 

The installation directories of the client and guardian are as follows: 

Operating system Component Installation Directory 

Windows 7 or 8 
32-bits 

Client C:\Program Files\Intel Education Software\Theft 
Deterrent client\ 

Guardian C:\Program Files\Intel Education Software\Theft 
Deterrent guardian\ 

Windows 7 or 8 
64-bits 

Client C:\Program Files (x86)\Intel Education 
Software\Theft Deterrent client\ 

Guardian C:\Program Files (x86)\Intel Education 
Software\Theft Deterrent guardian\ 

Debian 7 Client /opt/TheftDeterrentclient/client/ 

Guardian /opt/TheftDeterrentclient/guardian/ 

Android Client /data/data/com.intel.cmpc.td.agent/ 

Guardian /data/data/com.intel.cmpc.td.guardian.service/ 

 

The location of the log files are as follows: 

Operating system Log 

Windows 7 or 8 C:\ProgramData\Intel\TheftDeterrent 

Debian 7 /var/theftdeterrent 

/opt/TheftDeterrentclient/client/Theft_Deterrent_clie
nt.autorun.log 

Android /data/data/com.intel.cmpc.td.agent/agent.log 
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Note: For devices running Android, it is recommended that you install the Android 
Debug Bridge (adb) to access the log files. For example, you can copy the log files to 
another directory with the following command: 

adb pull /data/data/com.intel.cmpc.td.agent/agent.log 

For more information about adb, see Android Debug Bridge. 

http://developer.android.com/tools/help/adb.html
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9. Troubleshooting 

9.1 Theft Deterrent server Installation Failed 

If the installation of the server failed, the install wizard displays an error message. Follow the 
solutions in this table according to the error message displayed. 

Error message Solution 

Environment variables not found. 

Your installation package might 
be corrupted. Please contact the 
designated support personnel. 

Installer files are missing. 

Installer is missing or incorrect.  

Failed to write in installer file. 

Installer file copying failed. 

Installer file removing failed. 

Deploying failed. 

SSL key creating failed. 

Webserver register failed. 

Database register failed. 

Broadcast register failed. 

Database setting failed. 

Socket Connecting failed. Please make sure that no 
database management tool is connected to the 
database. 

Disconnect any database 
management tool from the 
database server. 

 

For more details about the installation error, check the log files in the following location: 

 On Debian: /var/log/theftdeterrentserver/install 

 On Windows:  %systemdrive%\log\theftdeterrentserver\install 
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10. FAQ 

1． How do I start, stop, and restart the server as well as check server status? 

Answer: The steps differ according to the server operating system: 

 Windows: Click Start menu -> All Programs -> Intel Education Software-> Theft 
Deterrent server -> click Start Server, Stop Server or Check Server Status. 

 Debian: Run the following commands with root privilege: 

service theftdeterrentserver start 
service theftdeterrentserver stop 
service theftdeterrentserver restart 
service theftdeterrentserver status 

Note: In Windows, if the server is running, you can restart the server by clicking the Start 
Server option. If the server is installed with a separate database, make sure that you run the 
command on both the web server and the database server. 

 

2． What do I do if the server webpages are distorted? 

Answer: First of all, make sure that you are using a web browser supported by the server: 

 Firefox 

 Chrome 

 Internet Explorer 8 or above 

Also, it is recommended that you clear the cache, cookies and history in your browser 
regularly. 

 

3． Why does the client version 2.x keeps rebooting the device after connecting with the 
server? 

Answer: The issue might be caused by either of the following reasons: 

 The client is connected with and approved by a wrong server. To solve the issue, 
modify the URL in the client connection settings to connect the client to its related 
server.  

 The system time on the device is earlier than that on the server. To solve the issue, 
synchronize the system time between the device and the server, delete the CMPC 
TDS SN.xxxxx certificate in your web browser and connect the device with the server 
again. 

 

4． Why does the client version 2.x keeps receiving a message asking to install SSL 
certificate? 

Answer: For clients with version earlier than 4.x, user must first install the CA certificate by 
accepting the install message before the client can be activated by the server. However, if 
the system time of the device is earlier than that on the server, the CA certificate cannot be 
installed correctly and the client will keep receiving the install message.  

To solve the issue, synchronize the system time between the device and the server. 
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5． What is the broadcast service? 

Answer: The broadcast service is the server component that performs the Automatic Server 
Broadcast, which functions only on LAN. 

In the current version of the server, the web service and the broadcast service are always 
installed on the same machine and no configuration is required for the broadcast service 
during deployment. Therefore, this service is not mentioned in the server overview.  

 

6． How to configure the TD SMS feature? 

Answer: TD SMS feature is applied to send TD short messages to receivers through an 
Android phone connected to TD server. 

 

receiver

TD server

ADB

TD SMS service

Phone 

driver
TD SMS App

Android 

Smart 

Phone

receiver

                       

 

To configure the SMS feature, at first, you need to complete the following installations on 
the server and Android phone sides respectively:  

 Server side 

 TD SMS service: It will be pre-installed in the server by the TD server installer 
package. 

 ADB (Android ADB service): For Windows, the ADB will be pre-installed in the 
server by the TD server installer package. 

 Phone driver: It needs to be downloaded from the phone webpage according to 
the specific phone type. 

 Android phone side 

 TD SMS App: It needs to be installed and launched in the Android phone to display 
a PIN code in order to identify the phone. 

Then, follow these steps to complete the configuration of the SMS feature: 

 Connect the server and the Android phone with a USB cable. 

 Log in the server webpage, and go to Settings->General->SMS Notification to input the 
PIN code shown by TD SMS App and set receiver’s phone number and the frequency of 
notification, then click the Save button. 
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7． Will I lose all server data when I uninstall the server? 

Answer: When you uninstall the server with the steps in chapter 4.6 or 5.5, all the data and 
settings of the server are not removed from the machine. Therefore, you can restore the 
data and settings with the upgrade steps when you install a new server on the machine. 

 

8． Can I upgrade from my server 3.x to a server 4.x in another language? For example, 
from a server 3.x in Spanish to a server 4.x in English. 

Answer: Yes. By following the upgrade steps in chapter Error! Reference source not found., 
you can upgrade your server 3.x to server 4.x regardless of the server display language. The 
server 4.x supports 4 displays languages: English, Spanish, Portuguese, and Turkish. You can 
change the display language on server 4.x webpage according to your needs.  

 

9． How do I find out the server support mode of my server? 

Answer: To find out the server support mode, you can go to the Home page to understand 
current mode server is running.  

 
Current server running mode include: 

Server Mode Comment 

Stand-alone 
server 

The server without any connection with other side. If it is with your 
owner Root Public Key, it can be activate or being activated. 

Central Server 
supported server  

The server was registered and activated to central server (or Sponsor 
server run as central server). 

Proxy server The server was registered and activated to Sponsor server. 

Sponsor server The server was being registered and activated by a Central-server 
supported or a Proxy server. 

 

10． How do I find the version of the server? 

Answer: The server version number is displayed at the button of the server webpage. 

 

11． How do I find the version of the client? 

Answer: Open the client tray manual from the client tray icon and click About. The client 
version number is displayed on the popup window. 
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11. Appendix 

11.1 Choose Root Key Pair  

Although Intel hosts a root CA server for external usage, it is strongly recommended that you 
deploy your own root CA server, which can support a central server for your Theft Deterrent 
solution.  

Also, by running your own root CA server, you will have full control of your Theft Deterrent 
solution. You will be responsible for the management of your own root CA server instead of 
interacting with the Intel root CA server admin.  

11.2 How to Understand the Network Stability 

You can understand the network stability through the network latency. Connect a test 
machine to the network to stand for the server and ping a URL or IP address, such as a 
device IP, with the following command. 

ping [URL] 

The result should include a series of numbers representing the communication delay, which 
looks as follows: 

Figure 44 - Check Network Latency 

 

Find the average round trip times, which is an approximate value for the network latency. 

Usage the latency should be smaller than 100ms. If the network latency always bigger than 
300ms, it mean your network is quite stable. 

11.3 How to Calculate the Required Network Bandwidth 

Once powered on, devices will send heartbeat requests to the server regularly (10 minutes 
by default). In general, the device will send 2.5K bytes to the server, and receive more than 
3.3K bytes from the server during each heartbeat.  

However, because the devices will not send heartbeat requests simultaneously, you must 
estimate the peak times of the heartbeat requests to calculate the required network 
bandwidth. 

 Peak times = peak requests / average requests 

In general, the minimal peak times is 2, but it is recommend that you use 4. 

The network bandwidth required at school for devices to connect with the server: 
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 Download bandwidth (Mbps) = 
online devices

heartbeat interval
∗ device download rate ∗ peak times ∗ 8 

 Upload bandwidth (Mbps) = 
online devices

heartbeat interval
∗ device upload rate ∗ peak times ∗ 8 

You can set device download rate = 3.3𝐾 𝑏𝑦𝑡𝑒𝑠/𝑠 and device upload rate = 2.5𝐾 𝑏𝑦𝑡𝑒𝑠/𝑠. 

The network bandwidth required for the web server: 

 Download bandwidth (Mbps) = 
online devices

heartbeat interval
∗ server download rate ∗ peak times ∗ 8 

 Upload bandwidth (Mbps) = 
online devices

heartbeat interval
∗ server upload rate ∗ peak times ∗ 8 

You can set server download rate = 2.5𝐾 𝑏𝑦𝑡𝑒𝑠/𝑠 and server upload rate = 3.3𝐾 𝑏𝑦𝑡𝑒𝑠/𝑠. 

The network bandwidth required for the download server: 

Network bandwidth (Mbps) = 
upgrade file ∗ number of devices

3600∗download hours per day∗download days
∗

8

valid bandwidth usage
 

For example, the upgrade file for the client is about 6.5MB in general. If the devices are 
powered on 8 hours a day, 100K devices try to download the upgrade file in 7 days, and only 
60% bandwidth usage is valid, then the required network bandwidth is as follows: 

6.5 ∗ 100000

3600 ∗ 8 ∗ 7
∗

8

60%
= 43𝑀𝑏𝑝𝑠 

In general, the more devices, the more valid bandwidth usage. It is recommended that set 
devices to complete the download in 7 to 14 days. 

11.4 How to Improve the Download Performance 

The download server sends upgrade packages to devices to fix bugs or update client 
features. The upgrade packages are generally larger than 6.5MB and therefore the download 
server will require large bandwidth for many devices to download the packages 
simultaneously. 

You can improve the download performance of your server with one or several of the 
following methods to reduce the bandwidth requirements.  

 Set up several download servers 

For example, if devices use two ISPs, A and B, to connect with the server, it would be 
too costly to put the download server into an Internet data centers (IDC) that has good 
connection to both ISPs. In such cases, you can set up download servers in both ISP A 
and ISP B. 

 Use Content Delivery Network (CDN) or cloud based download server 

Because client upgrade occurs only occasionally, you can use a CDN service or cloud 
based download server instead of setting up your own download server. For more 
information, please contract CDN or cloud service provider. 

 Set the HTTP proxy in the school 

If the schools have HTTP proxy, you can configure the devices to use the proxy, which 
saves download bandwidth and time. 

11.5 How to Back up Theft Deterrent server 

To back up the server, follow these steps: 

1. Log on the server and open the Advanced page under Settings. 
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Note: You must complete the pre-configuration steps before you can access the 
Advanced page. 

2. Click the Back up button. 
3. To protect the backup files with password, select the option and input a password.  
4. To save a copy of the backup file to local disk, select the option. 
5. Click Back up. 
6. If you chose to save a copy, select a location and save the file. 

Note: The password must be 6 to 30 characters in length. This password will be 
required when you restore the server. 

Figure 45 - Back up the server 

 

 


